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HoloVision - Where
Holography Goes Digital

What HoloVision Does

HoloVision is an advanced, scientific application for digital holography. Holo-
Vision can capture holograms with the aid of a digital camera or import
holograms in the form of JPG, BMP, GIF and TIF files. Two reconstruc-
tion methods - the Fresnel and convolution method - form the basis of the
application and simulate wavefield propagation. Different filters and image
processing capabilities make the software a useful tool in any kind of optical
measuring technique that utilizes digital holography.
HoloVision can also export files to WYKO Vision32 datasets and commu-
nicate with Matlab via Active X.

HoloVision 2.2 is an open source program available for free under a GNU
General Public License as stated in App. D. It is released without warranty
of any kind. Source code is available upon request.

The Making of HoloVision

In 1999 Øystein Skotheim and the author needed software for acquisition of
holograms and numerical reconstruction of wavefronts. The obvious choice
was to write our own software, and the result was a Windows based appli-
cation, HoloVision 1.0, released1 in June the following year.

As this version had limited capabilities, Øystein dedicated plenty of time
and a large part of his diploma thesis to the development of the 2.1 version.
The major upgrades included

1This first version of HoloVision never had an official release, but is described in Ref.
[1]
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• changing the FFT library for faster Fourier transform computations

• implementation of different reconstruction methods with several image
enhancing capabilities

• JPG, BMP, GIF and TIF support in order to collect holograms from
other sources than our Hamamatsu digital CCD camera

A description of HoloVision 2.1 can be found in his report on digital holog-
raphy (Ref. [2]).

As of today HoloVision has reached its 2.2 version. It contains features that
have been useful to us, but of course, there is always room for improvement.
Major updates in HoloVision 2.2 are

• WYKO Vision32 dataset export option

• Modified numerical lens, convolution algorithm and Fresnel algorithm

• Two zero mask filters (low- and highpass)

• Calculator for setup and reconstruction parameters

These updates are briefly described in Ref. [3].

Bug Report

We are happy to get reports on bugs in our software. Please explain what you
did prior to the occurrence and include the error messages that appeared, if
any.

Contact Information

If you want to aid us in the development of HoloVision, if you want to let
us know about bugs, or if you just want to send us any comments: do not
hesitate to contact us. As of June 25, 2001, our email addresses are:

• Vegard L. Tuft:

vegard.tuft@mailbox.as

• Øystein Skotheim:

oystein@edge.no
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You can find up-to-date information about HoloVision, including the latest
version of the software, here:

www.edge.no/projects/holovision/
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Chapter 1

Getting Started

1.1 Computer System Requirements

• MS Windows 95 OS or higher (tested with 95, 98, NT 4.0 and 2000)

• 133 MHz Pentium CPU or equivalent (500 MHz Pentium III CPU or
higher recommended)

• 32 MB RAM (256 MB or more recommended)

• Less than 10 MB of hard disk space (excluding Matlab and ITEX
software)

In addition, the following soft- and hardware is required if you want to use
the camera and grabbing facilities:

• ITEX (ITEX SDK 3.3.1 was used in the development of HoloVision)

• IC-PCI framegrabber

• Hamamatsu C4745-95 digital CCD camera with camera controller

1.2 Obtaining and Installing HoloVision

You can install HoloVision 2.2.1 from the accompanying CD-ROM or down-
load the latest zip file from the HoloVision web site at

www.edge.no/projects/holovision/

1
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1.2.1 Installing HoloVision From the CD-ROM

1. Insert the CD into the CD drive of your computer.

2. The setup program should start automatically. If not, run the setup.exe
file in the main directory of the CD-ROM.

3. Follow the instructions on the screen. You can choose between three
versions:

Light version All functionality included except Active X communi-
cation with Matlab and ITEX support for camera communica-
tion.

Matlab release All functionality included except ITEX support for
camera communication.

Full version Contains all functionality, including Active X commu-
nication with Matlab and ITEX support for camera communi-
cation. This version is only of interest if you have a Hamamtsu
C4742-95 digital CCD camera and an IC-PCI framegrabber.

• Note!
During the installation process the setup program may say it is in-
stalling the full version although the Light or Matlab release was cho-
sen. The chosen version will be installed.

1.2.2 Installing HoloVision From a Zip File

1. Download the zip file to your hard disk.

2. Unzip it into a temporary folder. If the Use folder names check box
in WinZip is checked, WinZip will create a folder for you.

3. Run the setup.exe file.

4. Follow step 3 in Sec. 1.2.1.

5. Delete the temporary folder and its contents if desired.

1.3 Installing ITEX and Connecting the Camera
(optional)

ITEX is necessary if you want to use the camera and grabbing facilities
of HoloVision. However, since ITEX is copyright of Coreco Imaging and
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requires a license, this software is not included on the accompanying CD-
ROM. Visit the Coreco Imaging website at

www.imaging.com

for more information. The Group of Technical Optics has its own license
of ITEX SDK1 3.3.1 intended for in-house development of software, like
HoloVision. The rest of this section is aimed at people at this group.

1. Insert the ITEX CD into the CD drive of your computer.

2. Run the setup.exe file and follow the instructions.

3. See the Hamamatsu C4742-95 instruction manual (Ref. [6]) on how to
connect the camera.

1.4 Installing Matlab (optional)

You may omit this section if you only need the Light version.

You can install Matlab before or after the installation of HoloVision. Matlab
is copyright of The MathWorks, Inc and requires a license.

• Follow the instructions in your Matlab documentation on how to install
Matlab the usual way; no extra steps are necessary.

• Make shure you have the Matlab release of HoloVision installed on
your computer. If not, remove the version you do have and/or install
the Matlab release.

• Note!
Matlab versions older than 5.3 may not support Active X.

1System Development Kit
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1.5 The HoloVision Environment

Dialog box

Info
window

Cross
Section
window

Menu bar

Toolbar

Dialog box

Matrix window

Dialog box

Matrix window

Image

Figure 1.1: The HoloVision environment

Users familiar with the MS Windows operating system will quickly get to
know the HoloVision environment seen in Fig. 1.1. The environment con-
sists of a menu bar, a toolbar, different dialog boxes and one or more matrix
windows. This section describes the different parts. In addition, the user is
introduced to the HVM matrix.

1.5.1 The Menu

Figure 1.2: The HoloVision menu

All the functions and image processing capabilities of HoloVision are acces-
sible through the menu at the top:
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File Items in the File menu are described in Chapter 2.

Edit The Edit menu options are described in Chapter 2.

Camera Chapter 3 explains how to communicate with the Hamamatsu
C4742-95 digital CCD camera.

Image The items in the Image menu are described in Sections 2.2.3 and
2.3.3 and Chapter 5.

Matlab The Matlab engine functionality is explained in Chapter 6.

View View menu options are described in Section 2.2 and Chapter 4.

Window The Window menu contains standard Windows options only. They
are not explained further.

• New Window

• Cascade

• Tile

• Arrange Icons

• Resize to Fit

• A list of all the open windows

Help The About box is the only choice in the Help menu.

1.5.2 The Toolbar

New Window Image Calculations

Send to Matlab

Help

Print
Calculator

Cross Section
Line Tool

Zero Mask Low

Crop Selection

FFT

Stop

Describe Image

Image Information

Edit Zero Mask

Zero Mask High

Show Selection

Reconstruct Wavefield

Camera Setup

Live

Grab

Open File

Save File

Figure 1.3: The HoloVision toolbar

The toolbar offers shortcuts to some of the most useful features. The icons
are:

New Window Opens an empty matrix in a new window (see Section 2.1.1).
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Open File Opens the Open dialog box (see Section 2.1.1).

Save File Saves the active matrix (see Section 2.1.2).

Grab Captures an image from the Hamamatsu digital CCD camera (see
Section 3.1).

Live Starts live grabbing (see Section 3.1).

Stop Stops live grabbing (see Section 3.1).

Camera Setup Opens the Camera Setup dialog box (see Section 3.2).

Send to Matlab Starts the Matlab engine and/or sends the active matrix
to the Matlab workspace (see Section 6.2).

Reconstruct Wavefield Opens the Reconstruct Wavefield dialog box (see
Section 5.1).

Image Calculations Opens the Calculations dialog box (see Section 5.2).

FFT Fourier transforms the active matrix (see Section 5.5).

Show Selection Activates/deactivates the Select tool described in Section
2.3.2.

Crop Selection Crops the selection as described in Section 2.3.2.

Zero Mask High Sets the matrix elements inside the selection to zero (see
Section 5.3).

Zero Mask Low Sets the matrix elements outside the selection to zero
(see Section 5.3).

Zero Mask Edit Opens the Zero Mask Filter dialog box (see Section 5.3).

Line Activates/deactivates the Line tool which marks the beginning and
end of the Cross Section window (see Section 2.2.2).

Image Information Opens/hides the Image Information dialog box (see
Section 2.2.1).

Cross Section Opens/hides the Cross Section window (see Section 2.2.2).

Describe Image Opens the Describe Image dialog box (see Section 2.2.3).

Calculator Shows/hides the Calculator for setup and reconstruction pa-
rameters (see Chapter 4).

Print Opens the Print dialog box (see Section 2.4).

Help Opens the About box.
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1.5.3 The HoloVision Matrix and the Matrix Window

HoloVision works on rectangular, two-dimensional arrays called HVM 2 ma-
trices. Each element contains a complex value which can be written as
z = a + bi, where the real part, a, and the imaginary part, b, are real
numbers.

HoloVision supports JPG, BMP, GIF and TIF images. The application
converts them to the HVM format when they are loaded - or exports HVM
matrices to any of the mentioned image types. How to do this is explained
in Sections 2.1.4 and 2.1.5.

The matrix window is a representation of an HVM matrix and displays it
as an image on the screen. The user decides what part of the matrix he or
she wants to see (see Section 2.2.1).
One or more matrix windows can be open at the same time.

1.5.4 The HoloVision Workspace

The HoloVision workspace is a collection of all the open HoloVision files
and the current setup parameters in the Reconstruct Wavefield dialog box.
Only the windows that have been saved as HVM files are included in the
workspace.
Section 2.1.3 explaines how to save and load workspaces.

2HVM means HoloVision Matrix, so the right term should be HV matrix



Chapter 2

Handling Files and Images

2.1 Opening and Saving Files

Opening and saving files is done as in most Windows-based software: from
the File menu.

2.1.1 Opening HVM Files

• Choose File—New... from the menu or New Window from the toolbar
if you want to create a new, empty HVM matrix. This is only necessary
if you want to grab images with the Hamamatsu camera (see Chapter
3).

• Choose File—Open... or the Open File icon if you want to open an
existing HVM file. A dialog box in which you can specify one or more
files will appear. Make sure the Files of type drop down list says
“HoloVision Matrix (*.HVM)”.

2.1.2 Saving HVM Files

• Choose File—Save as... if you want to save the active HVM matrix
under a new name.

• Choose File—Save or the Save File icon if you want to save your
changes to the active file.

• Note!
The user is not asked to save the file when closing it. Any changes
done after it was changed the last time, will be lost.

8
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Setup Parameters

In addition to the matrix data, each HVM file contains the values of four
setup parameters:

Source Distance Wavelength Pixel size

These are essential to the reconstruction process and are explained in Section
5.1.

Change and save the setup parameters by following these steps:

1. Open the Reconstruct Wavefield dialog box by choosing Image—Reconstruct...
from the menu or clicking the Reconstruct Wavefield icon on the tool-
bar.

2. Edit the four parameter values. Source is only available if Reference
Type is “Spherical wave”.

3. Save the file.

File Comment

You can also comment each HVM file by following this procedure:

1. Open the Describe Image dialog box by choosing Image—Describe...
from the menu or clicking the Describe Image icon on the toolbar.
This dialog shows the comment associated with the active matrix.

2. Enter some text. The comment can be as long as your computer
system allows.

3. Click Save & Close to save the text and exit the dialog.

4. Save the file if you want the comment to stay with the file even after
it has been closed.

• Note!
If you close the file without saving it, the comment will be erased.

2.1.3 Working with Workspaces

A workspace is a collection of the open HVM files and the current values of
the four setup parameters

Source Distance Wavelength Pixel size
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Matrix windows that have not been saved yet, for instance recently imported
JPG, BMP, GIF and TIF images, are not included.
A workspace can be saved as an HWS file. It contains a list of all the HVM
files in the workspace; the files themselves are not included. This means
that any alterations done to one file in a workspace will affect all the other
workspaces where this file is listed. In addition, if a HVM file is renamed or
moved, the file can not be opened when the workspace is loaded.
The HWS file contains its own set of setup parameter values independent of
the values associated with each HVM file.

Saving a Workspace

1. Open and/or save the HVM files you want to include in the workspace.

2. Open the Reconstruct Wavefield dialog box by choosing Image—Reconstruct...
from the menu or clicking the Reconstruct Wavefield icon on the tool-
bar.

3. Edit the setup parameter values. These are the values the dialog box
will display when the workspace is loaded. They come in addition to
the values associated with each HVM file.

4. Save the workspace by choosing File—Save Workspace....

Loading a Workspace

1. Choose File—Load Workspace... from the menu and choose a file in
the dialog box that opens.

2. All the HVM files listed in the HWS file will open, and the setup
parameter values are displayed in the Reconstruct Wavefield dialog
box.

2.1.4 Importing JPG, BMP, GIF and TIF Images

1. Choose File—Open... from the menu and a dialog box opens.

2. Specify the type of file you want to import in the Files of type drop
down list.

3. Choose one or more files to open. JPG, BMP, GIF and TIF images are
automatically converted to HVM matrices. The real part contains the
original image, while the imaginary part is set to zero. Color images
become black-and-white by taking the average of the three colors red,
green and blue.
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2.1.5 Exporting to JPG, BMP, GIF or TIF Format

When exporting a HVM file to one of the JGP, BMP, GIF and TIF formats,
the resulting file will contain the image as seen on the screen.

1. Specify what part of the HVM matrix to display and the intensity
scale in the Image Information window.

2. Choose File—Export as... from the menu and a dialog box opens.

3. Specify the file format in the Files of type drop down list.

2.1.6 Saving as WYKO Vision32 Dataset

Unwrapped phase maps from HoloVision can serve as raw data for further
processing and surface plots in the WYKO Vision32 software from Veeco
Instruments. HoloVision exports HVM matrices to an ASCII file format
that WYKO Vision32 can read.

1. Choose File—Export as... from the menu and a dialog box opens.

2. Choose “WYKO Vision Dataset (*.ASC)” from the Files of type drop
down list.

3. Enter a file name without any extension or with the extension “asc”
or “ASC”.

4. Click the Save button and the WYKO Vision32 Parameters dialog
box opens. This contains four fields:

Height Calibration Data for calibrating the surface plot in WYKO
Vision32. As of today no calibration algorithms have been imple-
mented in HoloVision, thus most of the parameters are unavail-
able. Reference Height specifies the height or depth of a measured
object.

Image Parameters Image width and height in number of pixels.

Setup Parameters You can spesify the number of pixels (along one
direction) in the CCD that captured the hologram. The wave-
length is collected from the HVM file. This is for calculating the
pixel size in the surface plot.
The CCD must be quadratic.

Comments The user can add a title and a note (subtitle) to the
ASCII file.
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Figure 2.1: Dialog box for saving WYKO Vision32 dataset information.

5. Click the Save File button.

• Note!
Only the real part of the HVM matrix is copied to the WYKO Vision32
dataset. This is the part occupied by the unwrapped phase.

2.2 Matrix and File Information

The Image Information and Cross Section windows provide useful informa-
tion about the active matrix. Both are accessible through the View menu
or the toolbar. You can also comment the HVM files, keeping important
notes and image files together.

2.2.1 Image Information

The Image Information window in Fig. 2.2 shows the name of and vital
information about the active matrix window. Some information is initially
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Figure 2.2: The Image Information dialog box in unexpanded (left) and ex-
panded (right) state.

hidden, but by clikcing the button with an arrow, the unexpanded state of
the dialog box alternates with the expanded state.

Show Decides which part of the matrix that is displayed on the screen.

• Real: a

• Imaginary: b

• Modulus:
√

a2 + b2

• Phase: arctan
(

b
a

)
modulo 2π

• Intensity: a2 + b2

• Log(Intensity): log10(a2 + b2)

Statistics The minimum, maximum and average pixel values.

Zoom Not implemented.

Intensity Scale Adjust the intensity in the image by using the slider or
entering a value. This specifies the saturation point as a percentage
of the maximum intensity. The matrix itself is not altered, only what
you see on the screen.

Resolution Image width and height in number of pixels.

File Version Number Specifies what version of the HVM format the file
is, 1 or 2, where version 2 is the newer. If the value is 0, the file format
is unknown, like when you open a JPG, BMP, GIF or TIF file.

Setup Parameters The four setup parameters associated with the file.
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Figure 2.3: The Cross Section window.

2.2.2 The Cross Section Window and Line Tool

The Cross Section window shows the value of each pixel along a line in the
matrix window. Default is the horizontal centerline. By clicking the Line
icon on the toolbar, a green marker becomes visible. You can now click and
drag anywhere in the matrix window and update the cross section. A red
tick marks the beginning of the marker; a blue tick marks the end.
Click the Line icon one more time to hide the green marker.

A red line indicates the average value in the Cross Section window.

2.2.3 File Comments

Figure 2.4: Describe Image dialog box for commenting HVM files.

Each HVM file has a comment field associated with it. Access this by
choosing Image—Describe... from the menu or the Describe Image icon on
the toolbar.
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2.3 Image Manipulation and Processing

Several image processing functions have been included in HoloVision. See
Chapter 5 for functions directly related to digital holography.

2.3.1 The Edit Menu

The standard Windows functions Undo, Cut, Copy and Paste are not im-
plemented in version 2.2 of this software.

2.3.2 The Select and Crop Tools

1. A rectangular section of the matrix can be marked by choosing Edit—Show
Selection from the menu or the Show Selection icon on the toolbar.
Click and drag to mark a section.

2. Click Edit—Crop Selection or the Crop Selection icon to paste the
selection into a new window.

Regardless of what is shown in the window (the real part, modulus or any
other option mentioned in Section 2.2.1), HoloVision copies the real part
of the active matrix into the real part of the new matrix and copies the
imaginary part of the active matrix into the imaginary part of the new.

2.3.3 Functions From the Image Menu

Duplicate Copies the active matrix into a new window.

Square Root Performs a square root operation on each pixel in the matrix,
but keeps the sign intact. If a+bi, where a is the real part and b is the
imaginary part, is the original pixel value, sign(a)�

√|a|+sign(b)�
√|b|i

is the new value.

Invert Inverts the real part of the matrix.

Render Two options are available (see Fig. 2.5), both overwrites the active
matrix:

• Square: Renders a black square in the middle of a white image.

• Harmonic: Renders a horizontal cosine pattern.
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2.4 Printing HVM Files

Other printing facilities than the default have not been implemented. The
File menu contain three choices:

Print... Opens the standard Print dialog box.

Print Preview Opens the standard Print Preview window. This does not
show the correct relation between image and page size.

Print Setup... Opens the standard Print Setup dialog box.
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Figure 2.5: The two render options: square (left) and harmonic (right).



Chapter 3

Camera Communication
(optional)

HoloVision was especially developed for communicating with a Hamamatsu
C4742-95 digital CCD camera through an IC-PCI framegrabber. If you want
to communicate with the camera and grab images, certain requirements have
to be fulfilled:

• ITEX has to be installed (see Section 1.3)

• IC-PCI framegrabber board must be installed

• Make sure the Hamamatsu C4742-95 digital camera is connected and
switched on

• The full version of HoloVision has to be installed (see Section 1.2)

3.1 Grabbing Images

• Acquire still images by choosing Grab from the Camera menu. You
can also click the Grab icon on the toolbar (see Fig. 1.3) or push the
F5 key. At least one matrix window has to be open, and the image is
transferred to the real part of the active matrix. The imaginary part
is set to zero.

• Start live grabbing by choosing Live or clicking the Live icon.

• Stop live grabbing by clicking the Stop icon.

18
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• Note!
Combining the live grabbing function with full resolution mode (see
Section 3.2) results in very slow update of the matrix.

3.2 Camera Setup

Figure 3.1: The Camera Setup dialog box.

Fig. 3.1 shows the Camera Setup dialog box accesible via Camera—Setup...
and the toolbar icon. Three camera parameters are available:

Shutter Sets the shutter time in milliseconds. You can use the slider, enter
a value or click the up- and down-arrows.

Frame size Sets the resolution of the acquired image, i.e. the number of
pixels. Two modes exist:

• Reduced resolution mode: 512x512 or 640(H)x512(V) resolu-
tion. This corresponds to the top- and leftmost quadrant of the
full resolution view.

• Full resolution mode: 1024x1024 or 1280(H)x1024(V). The
latter is the maximum resolution attainable with this camera.
Live grabbing is not recommended with this mode selected.

Contrast Two slides adjust the gain and offset.

Three buttons are available in the dialog box:

Apply Activates the shown settings.

Reset This button does nothing.

Close Closes the dialog box. Click Apply before Close if you want your
new settings to become active.
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3.3 Camera Terminal Communication

Choosing Camera—Terminal... enables you to send predefined commands
directly to the camera. These include parameter setting commands (like
shutter time and output data number), correction commands (like gain and
offset), status commands and more. The dialog box looks like Fig. 3.2.
See Chapters 9-4 and 9-6 in Ref. [6] for a complete list of commands.

Figure 3.2: The Camera Terminal Communication dialog
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The Calculator

HoloVision provides the Calculator for easy and fast calculation of five es-
sential setup and reconstruction parameters.

Figure 4.1: The Calculator for setup and reconstruction parameters

4.1 How to Use the Calculator

1. Open the calculator by choosing View—Calculator from the menu or
clicking the Calculator icon on the toolbar.

2. You will see a dialog box that looks like Fig. 4.1. Each parameter has
its own page. A page contains the values that are necessary to specify
before calculating this parameter.

21
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3. Choose a parameter to calculate, enter your desired values and click
the Calculate button. The result is displayed in the little window
above the Calculate button.

4. Click the Reset button if you want to reset all the pages to their default
values.

5. The Close button closes the calculator.

4.2 Parameters to Calculate

Object distance Minimum distance between the object and the hologram
plane for a given object size. Specify the one-dimensional size (width
or height) of the object, wavelength of the light and the detector pitch
of the CCD chip.

Object size The maximum one-dimensional size of the object (width or
height) for a given distance between object and CCD. Specify object
distance, wavelength and the detector pitch of the CCD chip.

Angular extent The maximum angular extent of the object for a given
wavelength and detector pitch. Specify the wavelength and detector
pitch.

Pixel size The pixel size in one direction in the reconstruction/image plane
when the Fresnel method is used. Specify reconstruction distance, the
wavelength, the pixel size of the CCD and the number of pixels the
hologram possesses in this direction.

Magnification Necessary magnification of numerical lens in order to get
the same pixel size in the image plane with the convolution approach as
with the Fresnel method. Specify reconstruction distance, wavelength,
the pixel size of the CCD and the number of pixels in one direction in
the hologram.

• Note!
You can check the mathematical reference in App. B if you want to
know what mathematical formulae HoloVision uses in the calculations.
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Reconstructions and
Calculations

The main purpose of HoloVision is to calculate, i.e. reconstruct, the optical
wavefront, both amplitude and phase, in a given reconstruction or image
plane. The basis for this computation is a digital hologram, either captured
directly with the Hamamatsu digital CCD camera (Chapter 3) or imported
from a JPG, BMP, GIF or TIF file (Section 2.1.4). Sample holograms are
included on the CD-ROM.

The theory that form the basis of the reconstruction dialog in Fig. 5.1 is
explained by Øystein Skotheim and the author in Refs. [2] and [3], respec-
tively.

This chapter describes the functions related to digital holography, while
Chapter 2 speaks of more general image processing functions.

5.1 The Reconstruct Wavefield Dialog Box

One dialog box presents all the available reconstruction methods, their op-
tions and the parameters that need to be set before calculating the wave-
front. The dialog opens by clicking Image—Reconstruct... from the menu
or the Reconstuct Wavefield icon on the toolbar.

Hologram view Here you specify which of the open matrices you want to
form the basis of your calculation. If Duplicate before reconstruct is
checked, HoloVision will open an empty matrix and place the result
here.

Reconstruction Method Choose between these three reconstruction meth-

23
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Figure 5.1: The Reconstruct Wavefield dialog box
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ods:

• The Fresnel method

• The convolution method

• The Fourier method

Reference Specify the type of reference wave used in the making of the
hologram:

• Plane wave

• Spherical wave: If this option is chosen, you can specify the
distance between the light source and the hologram plane in the
Source text box. The sign of the distance follows the same con-
ventions as used in Refs. [1], [2] and [3], i.e. a negative sign means
the source was at the same side of the hologram as the object.

• Custom: If you have a recording of the reference wave (and this
is in an open window), you can use this in stead of the numerically
calculated reference. Choose this option and specify the correct
matrix in the Reference view section.

• Antiparallel wave: A plane wave with a negative sign.

In the reconstruction process the reference wave can be numerically
tilted by an angle given by the Tilt angle 1 and Tilt angle 2 in the
horisontal and vertical direction, respectively. Use this function to
place the object in the middle of the reconstructed image, but note
that only small angles of 1-2◦ are necessary.

• Note!
With the Fourier method the reference has to be a spherical wave
with its source positioned in the object plane. As a consequence
neither Type, Source nor Distance can be specified.

Filters HoloVision can improve the image quality and its signal to noise
ratio in three ways.

• Mean Value Subtraction: The MVS function calculates the
mean value, which is subtracted from the hologram before recon-
struction, thus creating a downshift in its intensity. The purpose
is to suppress the so-called dc term which can be seen as a bright
central square in the middle of the reconstructed wave field. See
for example Ref. [2]. The best result is obtained with a plane
reference wave.
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While negative intensity values are optically impossible, they are
indeed numerically feasible and may result from this subtraction.

• High Pass Filter: A spatial highpass filter removes slowly vary-
ing periodic noise while keeping important image information of
higher spatial frequencies intact. This is a way to (partly) remove
the disturbing “cloud” also seen in the middle of a reconstruction.

• Contrast Enhance: Not implemented.

• HRO Subtraction: This function requires three recordings: a
recording of the object field alone, one of the reference field alone
(to be specified in the Object View and Reference View, respec-
tively), and one of the hologram. The reference and object waves
are then subtracted from the hologram, leaving the desired in-
terference terms behind. The result is a reconstruction with the
bright center and the surrounding noise at least partly removed.

Intensity Specifies the intensity scaling in the reconstructed image. The
value is the saturation point as a percentage of the maximum intensity.

Reference View Choose (among the open windows) which matrix you
want to use as a reference recording in the reconstruction. Available
with the Custom option in the Reference section or when the HRO
Subtraction box is checked.

Object View Choose (among the open windows) which matrix you want
to use as an object recording in the reconstruction. Available when
the HRO Subtraction box is checked.

Parameters Some of these parameters need to be set, depending on the
reconstruction method and type of reference wave:

• Distance: This parameter has different meaning for the different
reconstruction methods.

– Fresnel: Distance from the hologram plane to the reconstruc-
tion (image) plane. When the distance is a negative value,
the reconstruction plane is on the same side of the hologram
as the object.

– Convolution: Distance from object to hologram plane. See
Section 5.1.1.

– Fourier: Not available with the Fourier method.

• Wavelength: The wavelength used when recording the holo-
gram.

• Pixel size: The pixel size of the CCD chip. HoloVision assumes
quadratic pixels.
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• Magnification: Magnification of numerical lens (see Section
5.1.1). Must be larger than 0 and less than 1. Enter 0 if you
want to omit the lens altogether. Available when “Convolution”
is checked in the Reconstruction method section.

• Defocus: Shifts the image plane when using the convolution
method and the numerical lens (see Section 5.1.1).

Show Value Specifies what part of the reconstruction result that is dis-
played on the screen. The alternatives are the same as in Section
2.2.1.

4F Transfer Filter This is a numerical implementation of an optical 4f
system with a spatial lowpass filter. Matrix elements outside a cen-
tral rectangle of specified width and height are set to zero. Use this
function to, for instance, mask off the virtual image, see Ref. [2].

Perform IFFT shift When this option is checked the upper left quadrant
of the reconstructed image is swapped with the lower right, and the
upper right is swapped with the lower left.

The Update View button refreshes the list of open windows in the Hologram
View, Reference View and Object View sections, while the Calculate and
Close buttons starts the reconstruction and closes the dialog box, respec-
tively.

5.1.1 How to Use the Numerical Lens With the Convolution
Method

A numerical lens in the hologram plane is available when using the con-
volution method. Based on the entered Distance and Magnification values,
HoloVision will find a new image plane by using the well-known lens formula.

1. Choose “Convolution” in the Reconstruction method section.

2. In the Distance box specify the distance between the object and holo-
gram. Entering a negative value will invoke a negative lens. A positive
sign invokes a positive lens.

3. In the Magnification box enter a value for the desired magnification of
the numerical lens.

• Use the calculator (Chapter 4) to find the correct magnification.

• The magnification must be larger than 0 and less than 1.

• Enter 0 if you want to omit the lens.
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4. Enter a value in the Defocus box if you want to reconstruct the wave-
front in a different plane than the automatically calculated one.

5.2 The Calculations Dialog Box

Figure 5.2: The Calculations dialog box

Click Image—Calculations... or the Image Calculations icon when you want
to perform simple arithmetics on your images, like subtracting two phases.
The Destination and Source boxes as seen in Fig. 5.2 list the open windows.
The result of the operation is put in the Destination matrix.

Add Adds each pixel value in the source matrix to the corresponding pixels
in the destination matrix.

Average Calculates the average of two corresponding pixels, one in the
source matrix and one in the destination matrix. The real and imagi-
nary parts are handled separately.

Average Intensity Calculates the average intensity of two corresponding
pixels and puts the result in the real part of the destination matrix.
The imaginary part is set to zero.
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Subtract Subtracts each pixel value in the source matrix from the corre-
sponding pixels in the destination matrix.

Subtract Phase Subtracts the phase of each pixel in the source matrix
from the corresponding phase values in the destination matrix and
puts the result in the real part of the destination. The imaginary part
is set to zero.

Clicking the Apply button starts the calculation, while clicking the Close
button closes the dialog box.

5.3 Zero Mask Filters

The zero mask filters in HoloVison multiplies your image with a RECT
function, meaning the area inside or outside your rectangular selection is set
to zero.

Highpass The real and imaginary parts inside the selection are set to zero.

Lowpass The real and imaginary parts outside the selection are set to zero.

5.3.1 Quick Filtering

1. Use the Select tool described in Section 2.3.2 to mark an area in the
image.

2. Click the Zero Mask High or Zero Mask Low button on the toolbar
(the filters are also available from the menu: Image—Filter—Zero
Mask).

5.3.2 How to Use the Zero Mask Dialog Box

Sometimes it is necessary to know the exact coordinates of the selection, for
instance when you want to make sure that the same area in two or more
images are masked off.

1. Open the Zero Mask Filter dialog box by clicking the Edit Zero Mask
Selection icon or choosing Image—Filter—Zero Mask—Edit... from
the menu when a file is open.
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Figure 5.3: The Zero Mask Filter dialog box

2. The dialog box shows the coordinates of the selected area, if any, and
the name of the active matrix. These data will update automatically
when another matrix becomes the active window.
The first coordinate is the horizontal, while the second is the vertical.
(0,0) is the upper left corner of the window.

3. Choose one of the open files and select a new area with the Select tool.
Click the Update Views button to see the coordinates of this selection.

4. If desired, modify the coordinates in the New coloumn.

5. Choose what type of filter you want to use in the Zero Mask Type drop
down list.

6. Choose the matrix you want to filter in the Apply to drop down list.
The active matrix window is automatically suggested. This function
enables an easy way to mask off the exact same area in two or more
images.

7. Check Duplicate before filtering if you want to keep the original image.

8. Click Apply to filter the matrix.

9. Click the Close button, click the Edit Zero Mask Selection or choose
Image—Filter—Zero Mask—Edit... to close the dialog box.
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• Note! The filter function uses the coordinates in the New coloumn.
These may differ from the selected area.

5.4 Phase Unwrapping Algorithms

Figure 5.4: The Unwrap dialog box

HoloVision provides the user with six choices in the Unwrap Image dialog
box available from the Image—Unwrap... menu (see Fig. 5.4):

• Horizontal Unwrap

• Vertical Unwrap

• Goldstein’s Cut Line

• Least Squares Unwrap

• Quality Guided

• Mask Cut
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Ref. [4] contains more information on the different unwrapping techniques
and a performance comparison.

In addition, the Unwrap Image dialog box gives access to lowpass and me-
dian filters. These algorithms can consider as many as 15 by 15 pixels in a
square surrounding the evaluated pixel.

When an unwrapping is done, four options are available:

Undo last operation Returns the last image.

Back to original image Returns the matrix as it was before any unwrap-
ping or filtering.

Exit and use this image Closes the dialog box.

Cancel and forget image Closes the dialog box and returns the matrix
as it was originally.

5.5 Other Calculations

The Image menu also provides some simple image processing tools:

FFT Fourier transforms the matrix by using a two-dimensional Fast Fourier
Transform. This function is also available through the FFT icon on
the toolbar.

Inverse FFT Fourier transforms the matrix by using an inverse two-dimensional
Fast Fourier Transform.

Shift The upper left quadrant of the image is swapped with the lower right,
and the upper right is swapped with the lower left.

Filter Provides the same MVS and highpass filters found in Section 5.1 in
addition to four median filters from 3x3 to 9x9.
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Communicating with Matlab
(optional)

6.1 The Matlab Engine

HoloVision uses AxtiveX to communicate with Matlab. This means that
HoloVision can start a separate Matlab process, send data to Matlab and
end the same process. The process is called an engine.

HoloVision sends your active matrix as a complex array of double precision
to Matlab. You can then process your arrays further using the functionality
that Matlab offers. If you are new to Matlab and want to learn more about
this language of technical computing, Ref. [7] is a good place to start.
Click Matlab in the menu bar to access the Matlab menu in HoloVision. A
shortcut is available on the toolbar.

6.2 Starting the Engine and Sending Arrays to
Matlab

1. Choose the matrix you want to send to Matlab.

2. The engine starts by clicking Send to Matlab. A new Matlab window
opens, and the matrix is transferred. This process will not affect other
Matlab processes opened manually by the user, either before or after
the engine startup.

3. By typing who or whos in the Matlab command window, you can verify
that the matrix has entered Matlab as a variable called holo (see Fig.
6.1).
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4. While the engine is open, you can send more matrices into the con-
nected Matlab workspace by clicking Send to Matlab repeatedly. Note
that the old holo variable is overwritten when you transfer a new ma-
trix and thus needs to be renamed if you want to keep it.

Figure 6.1: The Matlab command window after engine startup and typing
whos on the command line.

• Note!
See the troubleshooting list in App. A if the engine won’t start

6.3 Stopping the Engine

• Clicking Stop Engine ends the process and closes the Matlab window.

• Exitting HoloVision also stops the engine. However, if Matlab doesn’t
close itself after a while you may have to close the Matlab window
manually.

• Note!
Note that closing the Matlab window manually (either by clicking the
upper right corner or choosing File—Exit in Matlab) does not stop
the engine. An error messsage will then appear if you try to restart
the engine.
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Example

Figure 7.1: Digital holography setup and apparatus for deformation analysis.

This chapter is a short demonstration of a setup used during the develop-
ment of HoloVision. The demonstration shows how the software and digital
holography can be used in optical interferometry. Two off-axis Fresnel holo-
grams [5] of an object in two different states was recorded.
The accompanying CD-ROM contains the recordings in this example.

The interested reader may consult Ref. [2] for a more detailed description
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of a similar setup, while Ref. [1] demonstrates the Fourier method. Contour
generation with the two-angle method and digital holography is explained
in Ref. [3].

Fig. 7.2 summarizes how the phase map is obtained in digital holographic
interferometry.

Subtraction of phases of reconstructions

&
High Pass Filter

Reconstructed
wavefield

Reconstructed
wavefield

Interferogram

HRO subtraction

Reconstruction

Object

Reference

Hologram

Filtered hologram

Object

Reference

Hologram

Filtered hologram

Object state 1 (initial state) Object state 2 (deformed state)

Mean Value Subtraction

Figure 7.2: How the interference phase is obtained with digital holography.



7.1. THE SETUP 37

7.1 The Setup
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Figure 7.3: Schematic presentation of the setup. M: mirror, S: shutter, BS:
beamsplitter, AF: attenuating filter, ML: microscope lens, SF: spatial filter,
CL: collimating lens, NL: negative lens, D: object size, d: object distance,
CBS: cube beam splitter.

Fig. 7.3 provides a schematic view of the setup that produced the off-axis
Fresnel holograms. It was basically a Mach-Zehnder interferometer.

Table 7.1: Setup parameters; all measured values are approximate
Distance object - hologram (CCD) d = 94 cm
Max. allowed angular extent of object θmax ≈ 2.7◦

Max. allowed object size Dmax = 4.4 cm
Actual object size (horizontal direction) D = 12 cm
Distance object - negative lens a = 24.3 cm
Distance image of object - negative lens a′ = 3.4 cm
Distance image of object - hologram plane (CCD) d′′ = 72.4 cm
Max. allowed object size with negative lens D′

max = 3.4 cm
Effective object size with negative lens D′ = 1.7 cm
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The following is a list of equipment used for capturing and processing of
holograms:

Optical table: TMC with vibration absorbers.

Laser: Spectra Physics Model 124B, Helium-Neon, multimode, 15 mW.

Beamsplitters: 2 VBA-200, adjustable with circular gradient. One split
the laser beam into an object and reference wave. The other reduced
the intensity of the reference.

Lenses: One 40/0.65 microscope lens and one negative lens with focal
length -4.0 cm.

Mirrors: Three mirrors with high-sensitive adjustable tilting.

Object: Metal plate with adjustable point load.

Filter: Spectra Physics Spatial Filter 332 with collimator.

Shutters: One shutter in each path of the interferometer.

Recording device: Hamamatsu C4742-95 digital CCD camera (black and
white) with serial interface for external camera control and with the
lens removed.

Computer: PC with 500 MHz Pentium III processor, 512 MB RAM, Win-
dows NT 4.0 OS, IC-PCI framegrabber device.

Software: HoloVision 2.2, ITEX SDK 3.3.1.

Miscellaneous: Magnetic supporters, optical mounts, posts, black card-
board (for screening of parasitic reflections) etc.

The object was a square metallic plate illuminated by a spherical wave from
a He-Ne laser operating at 633 nm. A deformating force was applied to the
plate by an adjustable point load as seen in Fig. 7.4.
Because of the large dimensions of the plate a negative lens was introduced
after the object. The lens created a smaller image of the plate, thus allow-
ing the CCD camera (with its limited resolution) to resolve the interference
fringes the setup produced. Again, the theory and a mathematical descrip-
tion is provided in Ref. [2].



7.2. THE RECORDINGS 39

Figure 7.4: Deformation object with point load.

7.2 The Recordings

Figure 7.5: Recordings of (from the left) hologram, reference wave and object
wave before deformation of the object. These are included on the CD-ROM
as plate1 hologram.hvm, plate1 reference.hvm and plate1 object.hvm, respec-
tively.
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Three recordings were made when the object was in the reference (i.e. unde-
formed) state: the hologram, the reference wave and the object wave. These
are shown in Fig. 7.5.

The point load behind the plate was adjusted and three new recordings were
made. These did not look much different from the images in Fig. 7.5.

To do:

1. Start HoloVision

2. Open the plate1 hologram.hvm, plate1 reference.hvm,
plate1 object.hvm, plate2 hologram.hvm, plate2 reference.hvm
and plate2 object.hvm files found in the holograms directory of the
CD-ROM. 1 denotes the reference state, while 2 denotes the deformed
state of the object.

7.3 The Reconstructions

The wavefields of both object states were reconstructed one at a time using
the parameter values in Table 7.2. The reconstruction algorithm uses the
reference and object recordings for filtering purposes (HRO subtraction).

To do:

1. Open the Reconstruct Wavefield dialog box by clicking the Reconstruct
Wavefield icon on the toolbar.

2. Choose “plate1 hologram” in the Hologram view field and check Du-
plicate before reconstruct.

3. Choose “plate1 reference” in the Reference view field.

4. Choose “plate1 object” in the Object view field.

5. Make sure the other values in the dialog box are as in Table 7.2.

6. Set the Show value to “modulus” and the intensity scale to “30%” to
get a decent image on the screen. Modulus is the square root of the
intensity.

7. Push the Calculate button.

8. Repeat steps 2 through 7 with the plate2 files.



7.3. THE RECONSTRUCTIONS 41

Table 7.2: Reconstruction parameters as used in the Reconstruct Wavefield
dialog box

Reconstruction method Fresnel
Reference wave type Plane wave
Reference source N/A
Tilt angle 1 0◦

Tilt angle 2 0◦

Mean Value Subtraction Yes
High Pass Filter Yes
Contrast Enhance N/A
HRO Subtraction Yes
Distance -72.4 cm
Wavelength 632.8 nm
Pixel size 6.7 µm
Magnification N/A
Defocus N/A
4f Transfer Filter No
Perform IFFT Shift Yes

9. Close the dialog box.

10. Save the reconstructions as plate1 rec.hvm and plate2 rec.hvm.

Fig. 7.6 shows the modulus and phase of one of the resulting matrices. In
the leftmost image the plate as seen through the negative lens is in focus.
The conjugate image is a blurred cloud to the left.

However, it is the phase difference between the two states which is of in-
terest in holographic interferometry. This was obtained by subtracting the
phase of one of the reconstructions from the phase of the other. This gave
the wrapped phase map modulo 2π in Fig. 7.7. Goldstein’s unwrapping
algorithm elliminated the phase steps and provided the smooth image to
the right in the aforementioned figure. The latter phase map is used in a
quantitative analysis of the deformation.

To do:

1. Open the Calculation dialog box by clicking the Image Calculations
icon on the toolbar.

2. Choose “plate2 rec” in the Destination field.

3. Choose “plate1 rec” in the Source field.



42 CHAPTER 7. EXAMPLE

4. Choose “Subtract phase” in the Operation drop down list.

5. Push the Apply button.

Figure 7.6: Intensity (left) and phase (right) of reconstructed wavefield.

Figure 7.7: Wrapped (left) and unwrapped (right) interferometric phase. The
images show only a section of the 1024x1024 matrix. This is the useful part
of the reconstructions.
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To do:

1. Repeat the entire process with the plate2 and plate3 files.

Figure 7.8: Cross section along the centerline of wrapped (left) and un-
wrapped (right) interferometric phase.

Another interferogram can be obtained by subtracting the reconstructions
themselves, not their phases. Fig. 7.9 shows the result. You can see that
the object is superimposed with fringes.

Figure 7.9: Object superimposed with interference fringes.



Chapter 8

A Developer’s Guide - by
Øystein Skotheim

This text is taken from Ref. [2] and included in the user’s manual for
completeness. Additional footnotes have been included by Vegard Tuft. The
chapter explaines how to install the HoloVision source code components for
further development. Readers merely interested in using HoloVision, not
developing it, may skip this chapter.

8.1 Obtaining and Installing HoloVision

Binaries and source code for the application HoloVision as of 28th of Febru-
ary 2001 is included on the attached CD-ROM1. Please visit the project’s
webpage:

http://www.edge.no/projects/holovision/

or contact the author2 for a more up-to-date version before further develop-
ment is done. The author can be reached via e-mail on oystein@edge.no

To aid in the further development of this application, I have made a recipe
for obtaining and configuring dependent tools and libraries. Below is a list
of requirements needed to build the full version of HoloVision. Some of the
libraries may be left out as stated in the footnotes if a reduced functionality
version is to be built.

Most of the libraries used in the development of HoloVision are publicly

1This refers to the CD-ROM that accompanied Ref. [2]
2Throughout this chapther the term “the author” means the author of the developer’s

guide, i.e. Øystein Skotheim
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available under the GNU General Public License. They are included on the
CD-ROM for convenience. As a consequence, HoloVision is also released
under the terms of the GPL. A GNU Copyleft is enclosed in appendix D
which states these terms. In general, the license allows anyone to use, modify
and distribute this software, provided that the modified work is released
under the same license terms as the original work. A proper copyright notice
and disclaimer of warranty should be attached to each of the published copies
along with a copy of the license terms.

8.1.1 Requirements

The following tools were used in the development of HoloVision.

• Microsoft Visual C++ version 6.0

– Compiler and integrated development environment (IDE)

• Microsoft Visual SourceSafe3

– Software for revision control

• ITEX-SDK 3.3.14

– Drivers and software for the IC-PCI framegrabber and camera
device

• Matlab 5.35

– Advanced mathematics software and API from MathWorks

• FFTW 2.1.3

– Fast Fourier Transformation library from the Massachusetts In-
stitute of Technology

• ImageMagick 5.2.6 and Magick++ API

– Software library for loading, storing and manipulating images in
various formats

3Not really required, but strongly recommended. GPL software like CVS is a free,
decent alternative

4May be left out if camera control and aquirement functions for the IC-PCI framegrab-
ber device and Hamamatsu digital CCD camera are not needed

5May be left out if ActiveX data transfer between Holovision and Matlab is undesired
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8.1.2 Installation

The installation process consists of several steps, and should be performed in
the order given below. The developer should be aware that failure to do so
may result in dependency failures between the components of the software.

• Install Microsoft Visual C++ 6.0

– Dynamically linkable debug and release versions of the Microsoft
Foundation Classes version 4.2 libraries are required. Microsoft
Developers Network (MSDN) is recommended. Microsoft Install-
shield was used for packaging of the binaries on the enclosed CD-
ROM.

• Install Microsoft Visual SourceSafe

• Install the ITEX SDK driver and software utilities.

– This exists on a separate CD, but is included on the HoloVision
CD-ROM for conveniece in the Itex directory.

– The following dynamic libraries should be accessible to HoloVi-
sion, and should reside either in the application directory or the
windows system directory:

itxavi10.dll
itxdrv10.dll
itxdsp10.dll
itxco10.dll

• Install Matlab and export library definitions for the ActiveX API to
Visual C++

– Library definitions for ActiveX calls to Matlab reside in the subdi-
rectory extern/include. These definition files must be exported
to a format accessible by the MSVC++ linker. The library tool
lib.exe accessible from the Visual C++ directory does the trick:

lib /def:libeng.def
lib /def:libmat.def
lib /def:libmx.def

– The directory where the libraries and header files reside has to be
added to the library and include file search path in the project
settings for HoloVision.

– Include the libraries libeng.lib, libmat.lib and libmx.lib in
the list of object modules for the linker
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– The following runtime libraries from Matlab are needed for the
application to run with Matlab ActiveX support:

libeng.dll
libmat.dll
libmatlbmx.dll
libmccmx.dll
libmi.dll
libmx.dll
libut.dll

• Install and configure FFTW for use as a dynamically linkable library
with proper operational data types

– The files fftw-2.1.3.zip and FFTW2.1.3.Win32.zip are included
on the CD-ROM. Uncompress FFTW and install the Win32 Vi-
sual C++ project definitions (latter file) in the subdirectory win32
at the desired location.

– As HoloVision makes use of the float datatype, and FFTW uses
double by default, a small change has to be done in the file
fftw.h. Make sure to change the following line

/* #undef FFTW_ENABLE_FLOAT */

into

#define FFTW_ENABLE_FLOAT

before compiling.

– Open the workspace fftw-win32.dsw from the Integrated Devel-
opment Environment and build release versions of the projects
FFTW2dll and RFFTW2dll.

– Add the directory location of FFTW to the library and header
file search path in Visual C++ and include the library defini-
tions FFTW2dll.lib and RFFTW2dll.lib in the project settings
of HoloVision.

– The symbol USE FFTW DLL should be added to the global prepro-
cessor definitions.

– The two DLLs FFTW2dll.dll and RFFTW2dll.dll must be ac-
cessible to the HoloVision application.

• Configure and install ImageMagick

– Uncompress the archive ImageMagick-5.2.6.zip included on
the CD to a suitable location.



48CHAPTER 8. A DEVELOPER’S GUIDE - BY ØYSTEIN SKOTHEIM

– Open and build the configure script from the workspace file configure.dsw
in the VisualMagick subdirectory

– Run the configure script and choose to build ImageMagick as
dynamic multi-threaded DLL runtimes. X11 stubs should be used
to mask out the X windows library calls. The demo, test and
contrib programs should be included in the build for examples on
how to use ImageMagick and the Magick++ API.

– The configure scripts generates a workspace file in the VisualMagick
directory. Load this file into the Visual Studio environment, and
choose to compile all projects.

– Binaries, library files etc. will be placed in the bin-subdirectory.
The following libraries and configuration files are required by
HoloVision and should be placed in the same location as the
executable:

CORE_DB_lcms_.dll
CORE_DB_magick_.dll
CORE_DB_ttf_.dll
CORE_DB_xlib_.dll
IM_MOD_DB_bmp_.dll
IM_MOD_DB_gif_.dll
IM_MOD_DB_jpeg_.dll
IM_MOD_DB_tiff_.dll
IM_MOD_DB_xc_.dll
LIBR_DB_JPEG_.dll
LIBR_DB_TIFF_.dll
LIBR_DB_ZLIB_.dll
delegates.mgk
magic.mgk
modules.mgk
rgb.txt

– The following library definitions should be supplied to the linker:

CORE_DB_magick_.lib
CORE_DB_xlib_.lib
CORE_DB_Magick++_.lib

Also be sure to include wsock32.lib as some of the libraries
are dependent on this file. The directories ImageMagick and
Magick++ should be added to the include files search path.

• References to all of the dependent libraries should reside in the project
file supplied with the source code (holovision.dsp), but you should
double check the search paths in case your utilities are installed into
different locations!
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You should now be able to compile the HoloVision project. Note that there
are two conditional defines to the preprocessor that are particularly impor-
tant, namely:

#define NO_MATLAB
#define NO_ITEX

If any of these symbols are defined, all references to Matlab and/ or ITEX
libraries will be left out. If ITEX is left out, all functionality related to
camera control and acquirement of live or still images will be lost. Without
Matlab ActiveX functionality, the software will of course not be able to
communicate directly with Matlab.

Further Documentation

Documentation6 for the different APIs used in the development of HoloVi-
sion can be found in the following references: Matlab API[8][9], ImageMag-
ick and Magick++[11], FFTW library[12].

6In addition, Refs. [6] and [10] provide necessary details on the Hamamtsu digital
camera and the ITEX SDK



Appendix A

Troubleshooting

This is a guide to some known problems.

A.1 General

• During installation the Install Wizard says it is installing the
full version

– Ignore this message if you chose the Light or Matlab release.

• Error message “Invalid handle while opening port” appears
when starting HoloVision

– Ignore it and push the OK button if you have the Light or Matlab
release installed.

– If you have the full version of HoloVision, this message appears
when you are starting the software and already have a HoloVi-
sion window open. Camera communication may not function
properly. In that case, close all HoloVision windows and restart
the software. You may even have to reboot your computer.

– The message can also appear if you have the full version, but not
ITEX installed.

• HoloVision is not responding

– Live grabbing was not stopped before doing any calculations.

• Cross Section window does not show any values

– Click somewhere in the Cross Section window and then click any
open HVM matrix.
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• Print Preview shows a bigger image than the actual print

– Printing functions have not been implemented in HoloVision.

• The WYKO Vision32 Parameters dialog box does not open
when exporting to WYKO Vision32 dataset

– Make sure you entered no file extension or one of the extensions
“asc” and “ASC” (not “aSc” or something else) when you saved
the file.

A.2 Camera Communication

See also the Hamamatsu instruction manual (Ref. [6]).

• All items in the Camera menu are unavailable

– Install the full version of HoloVision.

• No response from camera

– Make sure the camera is connected and switched on.

– Exit HoloVision and restart the software. A computer reboot
may be necessary.

• Grabbed image does not have the selected resolution

– Remember to click the Apply button before closing the Camera
Setup dialog box.

• Update of live grabbing is very slow

– Live grabbing in full resolution mode is not recommended.

– You may have too many programs open at the same time.

• HoloVision is not responding

– You may have started live grabbing two consecutive times.

– You may have started a calculation before stopping live grabbing.
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A.3 Matlab

• All items in the Matlab menu are unavailable

– Install the Matlab release or full version of HoloVision.

• Error message “Failed to open engine” appears when opening
Matlab engine

– Make sure Matlab is installed on your computer.

– If Matlab is installed, check which version. Versions older than
5.3 may not support engine operations. The engine does not seem
to work with the new 6.0 version.

– If it is the first time you are using the engine, you may have to
open Matlab manually before starting the engine.

• Error message “Unable to put array into Matlab” appears
when sending arrays to Matlab

– This message appears if Matlab was closed manually while an
engine was still running. Stop and restart the engine.

• Matlab does not close when the engine was stopped

– It may take some time before Matlab exits.

– Close Matlab manually if it still does not exit.
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Mathematical Reference

This appendix summarizes the mathematical formulae used in HoloVision.

B.1 List of Symbols

amn The real part of element (m,n) of the HoloVision matrix
α Tilt angle 1, horizontal direction
bmn The imaginary part of element (m,n) of the HoloVision

matrix
β Tilt angle 2, vertical direction
∆ξ Pixel size (detector pitch) of the CCD chip
∆x′ Pixel size in reconstructed image, i.e. in the image plane
λ Wavelength of the lightwaves
θ Angular extent of object
θmax Max. allowed angular extent θ of object
b′(n,m) The reconstructed wavefield in the image plane
d Distance between object and hologram plane (CCD)
d′ Distance between hologram plane (CCD) and

reconstruction (image) plane
D Object size (i.e. width or height)
ddf Defocus distance
Dmax Max. allowed object size D
dref Distance between hologram plane (CCD) and

reference wave source
DFT{m} The discrete two-dimensional Fourier transform of the

function or matrix m
f Focal length of the numerical lens
h(k, l) Hologram
h′(k, l) Filtered hologram
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IDFT{m} The discrete two-dimensional inverse Fourier transform
of the function m

M Number of pixels in one dimension
MF The value of MNL required to get the same image with the

convolution method as with the Fresnel method
MNL Magnification of numerical lens used in the convolution

method
N Number of pixels in one dimension
o(k, l) Object wave
r(k, l) Reference wave
z Cartesian coordinate along the optical axis

B.2 The HoloVison Matrix

The HoloVision matrix consists of elements with complex values. Element
(m,n), where m denotes the row number and n the coloumn number, can be
written as the expression amn + bmni. a is the real part, b is the imaginary
part, and i is the imaginary unit defined by i =

√−1.

B.3 Show Values

Specifies what part of the matrix to display on the screen.

Real: amn

Imaginary: bmn

Modulus:
√

a2
mn + b2

mn

Phase: arctan
(

bmn
amn

)
modulo 2π

Intensity: a2
mn + b2

mn

Log(Intensity): log10(a2
mn + b2

mn)

B.4 The Calculator

Min. distance between object and hologram plane:

d =
2∆ξD

λ
(B.1)
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Max. allowed object size:

Dmax =
λd

2∆ξ
(B.2)

Max. allowed angular extent of object:

θmax = arcsin(
λ

2∆ξ
) (B.3)

Pixel size in the reconstruction plane (Fresnel method):

∆x′ =
λd′

N∆ξ
(B.4)

Magnification (convolution method):

MF =
N(∆ξ)2

λd′
(B.5)

B.5 Fourier Transforms

The discrete two-dimensional Fourier transform DFT{m} of a function or
matrix m is defined as

DFT{m} =
N−1∑
k=0

M−1∑
l=0

me−2πi(nk
N

+ ml
M

) (B.6)

in HoloVision.

IDFT{m} =
N−1∑
k=0

M−1∑
l=0

me2πi(nk
N

+ ml
M

) (B.7)

is the inverse transform.

A transform followed by an inverse transform will multiply the matrix by
N · M .
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B.6 Reconstruction Methods

Fresnel method:

b′(n,m) = e
− iπd′λ

NM∆ξ2
(n2+m2)

· IDFT{h(k∆ξ, l∆ξ) r(k∆ξ, l∆ξ) e
iπ

d′λ (k2+l2)∆ξ2}
(B.8)

Convolution method:

b′(n,m) = IDFT{DFT{h(k∆ξ, l∆ξ) · r(k∆ξ, l∆ξ)} · G} (B.9)

where the function G is defined by

G = exp




2πid′

λ

√√√√
1 −

λ2
(
n + N2∆ξ2

2d′λ

)2

N2∆ξ2
−

λ2
(
m + M2∆ξ2

2d′λ

)2

M2∆ξ2



(B.10)

Fourier method:

b′(n,m) = IDFT{h(k∆ξ, l∆ξ)} (B.11)

B.7 Reference Wave Types

Plane:

r(k, l) = 1 (B.12)

Spherical:

r(k, l) = e
−iπ

dref λ [k2+l2]∆ξ2

. (B.13)

Antiparallel:

r(k, l) = −1 (B.14)

B.8 Tilt

The reference wave (i.e. the hologram) is multiplied by a phase factor given
by

e
i2π
λ

l∆ξ sin α · e i2π
λ

k∆ξ sinφ (B.15)
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B.9 Filters

HRO subtraction:

h′(k, l) = h(k, l) − r(k, l) − o(k, l) (B.16)

Mean Value Subtraction:

h′(k, l) = h(k, l) − 1
NM

N−1∑
k=0

M−1∑
l=0

h(k∆ξ, l∆ξ) (B.17)

4f Filter:

h′(k, l) = IDFT{RECT (DFT{h(k, l)})} (B.18)

B.10 Numerical Lens

The hologram is multiplied by the lens factor

e
− i2π

λ
ξ2+η2

2f (B.19)

where the focal length is given by

f =
MNLd′

MNL ± 1
. (B.20)

The upper sign in the denominator is used when d’ is positive

The new reconstruction distance is

±MNLd′ + ddf . (B.21)

B.11 Calculations

Available matrix operations are listed below. All but one operate on two
operands.

Add:

amn,1 + bmn,1i = amn,1 + amn,2 + (bmn,1 + bmn,2)i (B.22)
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Average:

amn,1 + bmn,1i =
1
2
[amn,1 + amn,2 + (bmn,1 + bmn,2)i] (B.23)

Average Intensity:

amn,1 + bmn,1i =
1
2
[
√

a2
mn,1 + b2

mn,1 +
√

a2
mn,2 + b2

mn,2] + 0i (B.24)

Square Root:

amn,1 + bmn,1i = sign(amn,1) �
√

|amn,1| + sign(bmn,1) �
√

|bmn,1|i
(B.25)

Subtract:

amn,1 + bmn,1i = (amn,1 − amn,2) + (bmn,1 − bmn,2)i (B.26)

Subtract Phase:

amn,1 + bmn,1i = arctan
(

bmn,1

amn,1

)
− arctan

(
bmn,2

amn,2

)
+ 0i (B.27)

(phases are modulo 2π)
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Shortcut Keys

Ctrl + A Opens the Calculations dialog box
Ctrl + D Duplicates the active matrix
Ctrl + E Opens the Zero Mask dialog box
Ctrl + I Opens the Image Information dialog box
Ctrl + K Opens the Calculator
Ctrl + M Starts the Matlab engine and/or sends the active matrix to

Matlab
Ctrl + N Opens a new, empty matrix
Ctrl + O Opens the Open file dialog box
Ctrl + Q Shows the Cross Section window
Ctrl + R Crops the matrix if an area is selected
Ctrl + S Saves the active matrix
Ctrl + T Opens the Reconstruct Wavefield dialog box
Ctrl + U Opens the Unwrap Image dialog box
F5 Captures a still image from the Hamamatsu digital camera
F10 Fourier transforms the active matrix
F11 Inverse transforms the active matrix
F12 Performs an inverse FFT shift on the active matrix
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The GNU General Public
Licence

The following is the text of the GNU General Public Licence, under the
terms of which the accompanying software is distributed.

GNU GENERAL PUBLIC LICENSE
Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.
675 Mass Ave, Cambridge, MA 02139, USA

Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to
share and change it. By contrast, the GNU General Public License is in-
tended to guarantee your freedom to share and change free software—to
make sure the software is free for all its users. This General Public Li-
cense applies to most of the Free Software Foundation’s software and to any
other program whose authors commit to using it. (Some other Free Software
Foundation software is covered by the GNU Library General Public License
instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price.
Our General Public Licenses are designed to make sure that you have the
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freedom to distribute copies of free software (and charge for this service if
you wish), that you receive source code or can get it if you want it, that you
can change the software or use pieces of it in new free programs; and that
you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to
deny you these rights or to ask you to surrender the rights. These restrictions
translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or
for a fee, you must give the recipients all the rights that you have. You must
make sure that they, too, receive or can get the source code. And you must
show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2)
offer you this license which gives you legal permission to copy, distribute
and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that
everyone understands that there is no warranty for this free software. If the
software is modified by someone else and passed on, we want its recipients
to know that what they have is not the original, so that any problems
introduced by others will not reflect on the original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We
wish to avoid the danger that redistributors of a free program will individ-
ually obtain patent licenses, in effect making the program proprietary. To
prevent this, we have made it clear that any patent must be licensed for
everyone’s free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification
follow.

Terms and conditions for copying, distribution and
modification

0. This License applies to any program or other work which contains a
notice placed by the copyright holder saying it may be distributed
under the terms of this General Public License. The “Program”, be-
low, refers to any such program or work, and a “work based on the
Program” means either the Program or any derivative work under
copyright law: that is to say, a work containing the Program or a
portion of it, either verbatim or with modifications and/or translated
into another language. (Hereinafter, translation is included without
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limitation in the term “modification”.) Each licensee is addressed as
“you”.

Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of running
the Program is not restricted, and the output from the Program is
covered only if its contents constitute a work based on the Program
(independent of having been made by running the Program). Whether
that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source
code as you receive it, in any medium, provided that you conspicuously
and appropriately publish on each copy an appropriate copyright no-
tice and disclaimer of warranty; keep intact all the notices that refer
to this License and to the absence of any warranty; and give any other
recipients of the Program a copy of this License along with the Pro-
gram.

You may charge a fee for the physical act of transferring a copy, and
you may at your option offer warranty protection in exchange for a
fee.

2. You may modify your copy or copies of the Program or any portion
of it, thus forming a work based on the Program, and copy and dis-
tribute such modifications or work under the terms of Section 1 above,
provided that you also meet all of these conditions:

(a) You must cause the modified files to carry prominent notices stat-
ing that you changed the files and the date of any change.

(b) You must cause any work that you distribute or publish, that in
whole or in part contains or is derived from the Program or any
part thereof, to be licensed as a whole at no charge to all third
parties under the terms of this License.

(c) If the modified program normally reads commands interactively
when run, you must cause it, when started running for such in-
teractive use in the most ordinary way, to print or display an
announcement including an appropriate copyright notice and a
notice that there is no warranty (or else, saying that you provide
a warranty) and that users may redistribute the program under
these conditions, and telling the user how to view a copy of this
License. (Exception: if the Program itself is interactive but does
not normally print such an announcement, your work based on
the Program is not required to print an announcement.)

These requirements apply to the modified work as a whole. If identifi-
able sections of that work are not derived from the Program, and can
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be reasonably considered independent and separate works in them-
selves, then this License, and its terms, do not apply to those sections
when you distribute them as separate works. But when you distribute
the same sections as part of a whole which is a work based on the
Program, the distribution of the whole must be on the terms of this
License, whose permissions for other licensees extend to the entire
whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your
rights to work written entirely by you; rather, the intent is to exercise
the right to control the distribution of derivative or collective works
based on the Program.

In addition, mere aggregation of another work not based on the Pro-
gram with the Program (or with a work based on the Program) on a
volume of a storage or distribution medium does not bring the other
work under the scope of this License.

3. You may copy and distribute the Program (or a work based on it,
under Section 2) in object code or executable form under the terms of
Sections 1 and 2 above provided that you also do one of the following:

(a) Accompany it with the complete corresponding machine-readable
source code, which must be distributed under the terms of Sec-
tions 1 and 2 above on a medium customarily used for software
interchange; or,

(b) Accompany it with a written offer, valid for at least three years,
to give any third party, for a charge no more than your cost of
physically performing source distribution, a complete machine-
readable copy of the corresponding source code, to be distributed
under the terms of Sections 1 and 2 above on a medium custom-
arily used for software interchange; or,

(c) Accompany it with the information you received as to the offer to
distribute corresponding source code. (This alternative is allowed
only for noncommercial distribution and only if you received the
program in object code or executable form with such an offer, in
accord with Subsection b above.)

The source code for a work means the preferred form of the work for
making modifications to it. For an executable work, complete source
code means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to control
compilation and installation of the executable. However, as a special
exception, the source code distributed need not include anything that
is normally distributed (in either source or binary form) with the major
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components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies
the executable.

If distribution of executable or object code is made by offering access
to copy from a designated place, then offering equivalent access to
copy the source code from the same place counts as distribution of the
source code, even though third parties are not compelled to copy the
source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program ex-
cept as expressly provided under this License. Any attempt otherwise
to copy, modify, sublicense or distribute the Program is void, and will
automatically terminate your rights under this License. However, par-
ties who have received copies, or rights, from you under this License
will not have their licenses terminated so long as such parties remain
in full compliance.

5. You are not required to accept this License, since you have not signed
it. However, nothing else grants you permission to modify or distribute
the Program or its derivative works. These actions are prohibited by
law if you do not accept this License. Therefore, by modifying or
distributing the Program (or any work based on the Program), you
indicate your acceptance of this License to do so, and all its terms
and conditions for copying, distributing or modifying the Program or
works based on it.

6. Each time you redistribute the Program (or any work based on the
Program), the recipient automatically receives a license from the orig-
inal licensor to copy, distribute or modify the Program subject to these
terms and conditions. You may not impose any further restrictions on
the recipients’ exercise of the rights granted herein. You are not re-
sponsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent in-
fringement or for any other reason (not limited to patent issues), con-
ditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do not
excuse you from the conditions of this License. If you cannot distribute
so as to satisfy simultaneously your obligations under this License and
any other pertinent obligations, then as a consequence you may not
distribute the Program at all. For example, if a patent license would
not permit royalty-free redistribution of the Program by all those who
receive copies directly or indirectly through you, then the only way
you could satisfy both it and this License would be to refrain entirely
from distribution of the Program.
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If any portion of this section is held invalid or unenforceable under any
particular circumstance, the balance of the section is intended to apply
and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any such
claims; this section has the sole purpose of protecting the integrity of
the free software distribution system, which is implemented by public
license practices. Many people have made generous contributions to
the wide range of software distributed through that system in reliance
on consistent application of that system; it is up to the author/donor
to decide if he or she is willing to distribute software through any other
system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to
be a consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in certain
countries either by patents or by copyrighted interfaces, the original
copyright holder who places the Program under this License may add
an explicit geographical distribution limitation excluding those coun-
tries, so that distribution is permitted only in or among countries not
thus excluded. In such case, this License incorporates the limitation
as if written in the body of this License.

9. The Free Software Foundation may publish revised and/or new ver-
sions of the General Public License from time to time. Such new
versions will be similar in spirit to the present version, but may differ
in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program
specifies a version number of this License which applies to it and “any
later version”, you have the option of following the terms and condi-
tions either of that version or of any later version published by the
Free Software Foundation. If the Program does not specify a version
number of this License, you may choose any version ever published by
the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free pro-
grams whose distribution conditions are different, write to the author
to ask for permission. For software which is copyrighted by the Free
Software Foundation, write to the Free Software Foundation; we some-
times make exceptions for this. Our decision will be guided by the two
goals of preserving the free status of all derivatives of our free software
and of promoting the sharing and reuse of software generally.

NO WARRANTY
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11. Because the Program is licensed free of charge, there is no
warranty for the Program, to the extent permitted by ap-
plicable law. except when otherwise stated in writing the
copyright holders and/or other parties provide the program
“as is” without warranty of any kind, either expressed or im-
plied, including, but not limited to, the implied warranties
of merchantability and fitness for a particular purpose. The
entire risk as to the quality and performance of the Program
is with you. Should the Program prove defective, you assume
the cost of all necessary servicing, repair or correction.

12. In no event unless required by applicable law or agreed to
in writing will any copyright holder, or any other party who
may modify and/or redistribute the program as permitted
above, be liable to you for damages, including any general,
special, incidental or consequential damages arising out of
the use or inability to use the program (including but not
limited to loss of data or data being rendered inaccurate or
losses sustained by you or third parties or a failure of the
Program to operate with any other programs), even if such
holder or other party has been advised of the possibility of
such damages.

END OF TERMS AND CONDITIONS
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CD-ROM Contents

This appendix lists the contents of the accompanying CD-ROM and its
directories.

E.1 Holovision 2.2.1 Win32 Install Binary

The installation files for HoloVision 2.2.1 are placed in the main directory
of the CD. Run setup.exe to install the software if the setup program does
not start automatically.

HoloVision 2.2 is distributed under the GNU General Public License found
in the license.txt file or in App. D.

E.2 Documentation

Documentation can be found in the doc directory.

• project.pdf : Numerisk rekonstruksjon av hologrammer i digital holo-
grafi ; Øystein Skotheim’s and Vegard L. Tuft’s joint project 1999/2000
(Ref. [1]).

• thesis os: HoloVision - a software package for reconstruction and
analysis of digitally sampled holograms; Øystein Skotheim’s diploma
thesis 2001 (Ref. [2]); ps and pdf formats.

• thesis vlt: Fringe resolution in digital holographic interferometry ; Ve-
gard L. Tuft’s diploma thesis 2001 (Ref. [3]); ps and pdf formats.
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• hv manual: HoloVision 2.2 User’s Manual in pdf and ps formats;
covers HoloVision 2.2.1.

E.3 Holograms

The recordings mentioned in Chapter 7 are included in the holograms direc-
tory.

• plate1 hologram.hvm: Hologram of initial state of object

• plate1 object.hvm: Object wave

• plate1 reference.hvm: Reference wave

• plate2 hologram.hvm: Hologram of loaded state of object

• plate2 object.hvm: Object wave

• plate2 reference.hvm: Reference wave

• plate3 hologram.hvm: Hologram of loaded state of object

• plate3 object.hvm: Object wave

• plate3 reference.hvm: Reference wave

Compare plate1 and plate2 OR plate2 and plate3 interferometrically to pro-
duce fringes.

E.4 Setup Images

Pictures of the object and experimental arrangement described in Chapter
7 are included in the setup images directory.
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